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1 Introduction 
The JSIMP tool, produced by Queen Mary as part of the SIMP project, provides quantitative 
risk management information at any stage in a major project. The tool, targeted at project 
managers and risk managers, enables users to enter as little or as much information they have 
about a project that can impact on its eventual success or failure. At any stage the tool will 
provide a prediction of a range of key project parameters such as the extent to which the 
project will go: above/below schedule, above/below agreed cost, above/below a satisfactory 
level of final system performance, likely impact on company reputation etc. Because the tool 
is based on an underlying Bayesian net (BN) model, predictions for any project parameter are 
full probability distributions rather point estimates. From the full distribution the tool can also 
show such statistics as means, variance etc.  
 
The underlying BN model (which was obtained using information provided by BAES risk 
assessors from the ASTUTE project) is hidden from users of the tool. Users simply enter 
project risk information via an intuitive questionnaire interface. Information they can enter 
ranges from information about staff quality through to project facilities. Users can also enter 
information about costs and schedules, such as the extent to which the project is allowed to 
overrun. Whenever new information is entered the tool will apply Bayesian propagation to 
update the probability distributions of all the unknown variables. The tool has a range of 
mechanisms for displaying its results. Users can also do powerful ‘what-if’ analysis, such as 
investigating how much better/worse certain procedures have to be in order to achieve 
particular performance or cost targets.  The JSIMP tool is written in Java and has been built 
on top of Agena’s BN architecture (called Minerva). 
 
The underlying BN model has undergone a number of changes [Reference 1]. The model is 
still heavily based on the risk categorisation by Astute [Reference 2] but it differs in the 
following ways: 
 
• Although the whole model is about risk assessment, items that were defined as ‘risks’ by 

BAES are actually represented by ordinal scale attributes that underlie those risks. For 
example, instead of a node representing ‘facilities’ risk, we now have a node representing 
the quality of facilities (ranging from low to high). The problem with representing risks 
directly is that a given risk can, at best, only take on the value of zero. This means that the 
model would not be able fully to support trade-offs. For example, if facilities are known to 
be an active risk area with a potential impact on the project budget, it might be decided to 
investigate whether an improvement in process efficiency could serve to counteract this 
negative impact. However, if process efficiency is treated as a risk such a trade-off is not 
possible; the best that can happen as a result of improving process efficiency is that it has 
no negative impact. Only if process efficiency is represented as an attribute with values 
ranging from low to high can it be allowed to have a positive impact in the model. 
Because the model should be able to support this kind of trade-off, the current version 
contains qualities that can have risk associated with them rather than risks per se. 

 
• State values have been added to all of the nodes in the network. Currently, for the sake of 

simplicity, the majority of the nodes have the state values Very Low, Low, Medium, High 
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and Very High. Cost and schedule nodes, however, are treated differently. The state values 
associated with these nodes are presented below with the corresponding node descriptions. 

 
• The model now incorporates a powerful representation of the relationship between cost, 

schedule and performance. This new representation, which emerged from discussion 
between Astute and RADAR, allows trade-offs between the three factors to be fully 
investigated. 

 
This document describes the main BN in Section 2. In Section 3 we present an example of 
using the model in the tool, while Section 4 is a user manual for the tool. 
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2 Overview of main JSIMP BN model 
 
The top-level BN model is shown in Figure 1 (this is actually a simplified view of the model 
since certain ‘dummy nodes’ are omitted). The rest of this section describes the nodes of the 
model in appropriate groups. MORE INFORMATION WILL APPEAR IN FINAL 
VERSION. 
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Figure 1: JSIMP Main BN Model 

 

2.1 Attributes associated with resource performance 

• Staff  
• Organisation Effectiveness  
• Planning 
• Facilities 
• Information 
• Procurement  
 
These nodes are all attributes that correspond to high-level risk areas defined by Astute and, 
currently, they all have the associated state values Very Low, Low, Medium, High and Very 
High. In the final version of the tool these nodes will all be broken down into the ‘indicators’ 
provided buy the ASTUTE team. 
 
• Subcontract Management 

This node represents the overall quality of the management of the subcontracting process. 
It can have an impact on both the Key Subsystem risk area and the Procurement risk 
area.  
 

• Motivation 
This node represents the underlying motivation of staff on the project and it can have an 
impact on the attributes represented by Staff and Management. Motivation can be 
influenced by the effectiveness of the organisation (Organisation Effectiveness).   
 

• Resource Performance 
This is a derived node that provides an overall 'score' based on observations of the other 
factors here. This node represents the quality of the contribution that the resources make 
to the project. Resource Performance has an impact on Cost Differential Implied by 
Project Attributes and Schedule Differential Implied by Project Attributes. 

 

2.2 Attributes associated with technical quality 

• Design Solution 
• Interfacing 
• Facilities 
• Obsolescence 
• Key Subsystem 
 
These nodes are all attributes that correspond to high-level risk areas defined by Astute and, 
currently, they all have the associated state values Very Low, Low, Medium, High and Very 
High. In the final version of the tool these nodes will all be broken down into the ‘indicators’ 
provided buy the ASTUTE team. 

Version 2_0 of SIMP BN Model and Tool 1_0.doc   12 June 2001 Page 6 of 40  



 
• Technical Facilities 

This node represents the quality of specifically those facilities that are used during the 
build process.  
 

• Overall Technical Quality 
This is a derived node that provides an overall 'score' based on observations of the other 
factors here. This node represents the quality of the contribution that the technical factors 
make to the project. It has an impact on Cost Differential Implied by Project Attributes 
and Schedule Differential Implied by Project Attributes. 

 

2.3 Attributes associated with process quality 

• Process efficiency 
• Requirements 
 
These nodes are all attributes that correspond to high-level risk areas defined by Astute and, 
currently, they all have the associated state values Very Low, Low, Medium, High and Very 
High. In the final version of the tool these nodes will all be broken down into the ‘indicators’ 
provided buy the ASTUTE team. 
 

2.4 Attributes associated with cost and schedule 

 
• Agreed cost differential above agreed cost 

This node represents the percentage differential between the current actual budget and the 
budget agreed at the start of the project. If this difference is positive (say 15%), then 
Agreed cost is higher than Actual cost (by 15%), which implies that the project is 
running within the planned budget. Conversely, if the difference is negative, then Agreed 
cost is lower than Actual cost, which suggests that the project is not running within the 
planned budget. This approach allows the BN to be used for projects of all sizes and costs 
but without the need for detailing a specific range of potential budgets.  

 
• Agreed schedule differential above agreed schedule 

This node represents the percentage differential between the current actual schedule and 
the schedule agreed at the start of the project. If this difference is positive (say 15%) then 
Agreed schedule is higher than Actual schedule (by 15%), which implies that the project 
is running within the planned timeframe. Conversely, if the difference is negative, then 
Agreed schedule is lower than Actual schedule, which suggests that the project is not 
running within the planned timeframe. This approach allows the BN to be used for 
projects of all sizes and costs but without the need for detailing a specific range of 
potential timeframes.  

 
• Budget constraints (cash flow) 

Version 2_0 of SIMP BN Model and Tool 1_0.doc   12 June 2001 Page 7 of 40  



 
• Business environment 

 

2.5 Outputs/predicted attributes 

 
• Cost differential implied by Project Attributes 

As well as an initial agreed cost and an actual cost at any given point, the project has 
associated with it a “real” cost, or budget, that is suggested by the project risk attributes. 
This cost is expressed as a percentage deviation from that of the nominal project. Thus a 
value of 15% here would mean that, because of the actual project attributes, the cost is 
likely to be 15% more than expected. 
 

• Schedule differential implied by Project Attributes 
As well as an initial agreed schedule and an actual schedule at any point, the project has 
associated with it a “real” schedule that is suggested by the project risk attributes. This 
schedule is expressed as a percentage deviation from that of the nominal project. Thus a 
value of 15% here would mean that, because of the actual project attributes, the schedule 
is likely to be 15% more than expected. 
 

• Actual Cost Differential 
This node represents the percentage differential between the actual project budget 
currently and the budget that is implied by the project risk attributes (represented by the 
node Cost Implied by Project Attribs). If this difference is positive, Cost Implied by 
Project Attribs is greater than Actual Cost, which suggests that the current budget is not 
realistic and does not fully take into account the potential risks associated with the project. 
The states of this node are intervals that express the percentage difference between the 
two parents.  
 

• Actual Schedule Differential 
This node represents the percentage differential between the actual project schedule 
currently and the schedule that is implied by the project risk attributes (represented by the 
node Schedule Implied by Project Attributes). If this difference is positive, Schedule 
Implied by Project Attributes is greater than Actual schedule, which suggests that the 
current schedule is not realistic and does not fully take into account the potential risks 
associated with the project.  
 

• Performance 
This node represents the overall performance of the system being built by the programme. 
Performance is directly influenced by two variables: the difference between the actual 
project schedule currently in place and the schedule that is implied by the project risk 
attributes (Actual/Implied Sched Diff) and the difference between the actual project 
budget currently in place and the budget that is implied by the project risk attributes 
(Actual/Implied Cost Diff). None of the project qualities (e.g. resources, requirements, 
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process efficiency) affect performance directly; their effects are mediated by 
Actual/Implied Sched Diff and Actual/Implied Cost Diff. 
 

• Reputation 
This node represents the reputation of BAE Systems in the commercial environment. BAE 
Systems’ reputation can be influenced both by the performance of the system built on the 
Astute programme (Performance) and by the perceived budget overspend 
(Actual/Agreed Cost Diff) or schedule overrun (Actual/Agreed Sched Diff). 
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3 Example: using the model 
The relationship between the nodes described in Sections 2.4 and 2.5 is fairly complex. In 
order to clarify this relationship it is instructive to consider what kind of cost, schedule and 
performance trade-off reasoning the model supports.  
 
To run the following example, open the tool and then open the scenario called "simp0". You 
should then see the 'questionnaire' in the main part of the screen as shown in Figure 2. 
 

 
Figure 2: Screenshot for scenario "simp0" 
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The scenario you have loaded already has some answers entered. You can change these 
simply by using the combo boxes or by entering values for those that have numeric answers. 
In this loaded scenario we have a classic ‘at risk’ project in the sense that many of the project 
attributes that we know about have values ‘very low’ or ‘low’. Also, note that the “actual cost 
above agreed cost” has a value 0 meaning effectively that this is a fixed price contract – it is 
not allowed to go over budget. The first simple use of the model and tool is as a scorecard-
type assessment; we can see how the model evaluates the overall technical quality and 
performance quality. To do this select the questions “overall performance quality” and 
“technical quality” and display their monitors by clicking on the monitors icon. Then select 
the “Calculate | Run Calculation” menu item. When the calculation (meaning full Bayesian 
propagation of the entire model) is completed you should see the monitors as in Figure 3. 
 

 
Figure 3: Distributions for “technical quality” and “overall resource performance” 

The distributions are centred around “low” in each case (although these is still a small 
probability in each case that it could be higher or lower). However, much more interesting 
than these predictions are the predictions for the output nodes. For example, select the 
monitors ‘Cost differential implied by Proj Qualities’ and ‘performance’ and again run 
Calculate. You should now see the monitors in Figure 4. 
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Figure 4 Predicted distributions for “cost differential implied by project attributes” and “performance” 

 
These predictions bring bad news. The cost differential says that, based on the project 
properties the cost overrun is likely to be between 20 and 30% (to compensate for the poor 
qualities). However, we know the actual cost is fixed. Hence, the performance is likely to be 
very low.  
 
Now remove the actual cost constraint and enter the value 30 for “Actual Cost diff above 
agreed cost” (in other words we increase the budget by 30% over the original agreed budget). 
After running Calculate the performance prediction improves as shown in Figure 5.  
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Figure 5: Updated performance prediction after increasing budget 

However, it is still below average. There are two reasons for this, both of which the model 
shows clearly.  
 

1. We still have poor technical quality and resource performance and these are not fully 
compensated by the increased resources. 

2. If we check the prediction for ‘Schedule differential implied by Project Attributes’ we 
find that the schedule differential is predicted to be around 30%, meaning that we 
really need to increase the schedule time by 30%. 

 
So now enter the value 30 in “Actual schedule diff above agreed schedule”. After running 
Calculate the prediction for performance is now looking good. Thus, given the poor quality 
attributes we can still deliver a good system, but only by significant cost and schedule 
overruns. Moreover, if you check the monitor for “reputation” you will see that this is tending 
toward low because despite the respectable system it is being delivered late and over budget. 
 
Now, replace the values entered for “Actual schedule diff above agreed schedule” and 
“Actual cost diff above agreed cost” with 0’s. In other words the project cannot go over 
budget or schedule. Suppose that we have a requirement for the performance to be excellent. 
Enter this as an observation in ‘performance’. What happens now is that both overall resource 
performance and technical quality increase significantly despite the evidence that these are 
poor.  
 
Finally, close the scenario and open the scenario labelled ‘simp1’. This shows how the tool 
can be used to directly compare different options for a project because you can view multiple 
scenarios at the same time. There are actually two scenarios here. To view the second scenario 
simply click the tab labelled ‘scenario 2’. Now select and display the monitors for 
‘performance’ and ‘Cost differential implied by Project Qualities’. After running Calculate 
you should see the screen shown in Figure 6. 
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Figure 6 Multiple scenario example 

 
Scenario 1 has mainly ‘high’ or ‘very high’ project observations, whereas scenario 2 has 
mainly ‘low’ and ‘very low’. Not surprisingly the differences in ‘performance’ and ‘Cost 
differential implied by Project Qualities’ are very significant. To bring the performance in 
scenario 2 more in line with that of scenario 1 we can increase the budget and schedule as 
shown in Figure 7. 
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Figure 7 Increasing budget and schedule on scenario 2 

 
 
 

Version 2_0 of SIMP BN Model and Tool 1_0.doc   12 June 2001 Page 15 of 40  



4  JSIMP TOOL USER MANUAL 
 

4.1 Introduction 

This appendix describes all the main components of the JSIMP tool (which are shown in the 
JSIMP application window in Figure 8) and how to use them.  
 

 
Figure 8 The JSIMP interface overview 

 
The main components are: 
 

• The menu bar. This has ‘File’, ‘Tools’, ‘Calculate’ and ‘Help’ menus. Section 4.2 
provides the details. 

• The explorer view. This contains a list of models (which are instances of the project 
level net and phase level nets) that have been loaded or imported into the overall 
model. More information about this can be found in Section 4.2. 

• The work area. This has two views (there are tabs for switching between the two), 
namely a questionnaire view (described in Section 4.4. and a BN view described in 
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4.5. In either case the work area contains the associated details of the model currently 
selected in the explorer view.  

• The monitor panel. This contains a set of monitors, where a monitor is an item that 
displays the probabilities for a given node in the underlying model after propagation. 
More information can be found in Sections 4.5.4 and 4.6.2. 

 
It is important to note that, by default, the JSIMP tool runs in editor mode (see Section 4.7) 
and the users are assumed to be systems users. Hence, this user manual is written from the 
perspective of JSIMP systems users rather than end users. The systems users will be using the 
toolset to generate their own applications by tailoring the models and questionnaires 
appropriately for a specific project. Section 4.7 describes how to create a (non-editable) 
application for end-users once the systems user has completed the tailoring. It is expected that 
systems users would provide a modified user manual for their own end-users. Such a user 
manual would be based on the relevant subsets of this manual embellished with information 
about the tailored models and questionnaires.  
 
It is therefore important that readers first understand the basics of the JSIMP method and 
models described earlier in this document before engaging with the tool. 
 
Finally in Section 4.9 there is a brief FAQ on using the application.  
 
 

4.2 The menu bar functions 

The menu bar contains functions to load, save and import models and scenarios. It also 
contains the calculation menu item, which is the only mechanism in JSIMP to propagate the 
underlying models. The menus can be seen in Figure 9.   
 
 

 
Figure 9 The menus 
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4.2.1 The File Menu Functions 
 
The file menu functions are concerned with model files and scenario files: 
 

• File > Open Model A model file should be viewed as a ‘project’; it is a collection of 
one or more BN models, which may or may not be linked. This menu item opens a 
dialog listing available model files (which have the extension ‘.cmp’). When using the 
‘Open Model’ operation any existing models will be closed. This is in direct contrast 
to the ‘Import Model’ function (see below), which simply adds the selected model to 
the collection of existing models. 

 
• File > Import Model This option, which requires users to have opened a model file, 

opens a dialog listing available model files. When a file is selected it is imported into 
the current model and all its component BN models are added to those in the current 
model. Importing does NOT close any of the existing models. Hence this is the main 
mechanism for building up larger domain-dependent models. 

 
• File > Save Model This saves all the models and links to a single ‘.cmp’ file. If this is 

the first time that the project has been saved during the application session (i.e. since 
starting JSIMP) then a dialog will appear prompting you to specify a path and file 
name. Any open scenarios are NOT saved with this file; they must be saved to a 
separate scenario file (see below). 

 
• File > Save Model As See the ‘Save Model’ menu item. Here a dialog will always 

appear promoting you to specify a path and file name  
 

• File > Remove This menu item is further broken down into a list of all the models in 
the current project. Clicking on one of these will remove that model from the project. 
Hence this function enables an individual model to be removed, along with any links 
that existed between it and other models in the current project. 

 
• File > Close Model This closes the all the models in the current project. 

 
• File > Open Scenario Since scenarios are model-dependent, this option (which opens 

a dialog listing all scenario ‘.scn’ files) is only available if the associated model file 
has been opened. Obviously there will be no ‘.scn’ files unless you have previously 
saved some (see below). 

 
• File > Save Scenario As A dialog appears prompting you to select a path and 

filename to which the scenario should be saved. Many different scenarios can be saved 
for the same model. However, if the associated model is changed then any scenarios 
previously saved for it may be invalid.   
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• File > Close Scenario This will remove all observations from all scenarios currently 
defined in the models. 

 
• File > Exit Closes down the application. NOTE: You will NOT be prompted as to 

whether you wish to save or not. 
 

4.2.2 The Calculate Menu Functions 
 
There is just one crucial function available. This function propagates all the open models. All 
open monitors will update during the propagation. Monitors that are created after the 
propagation will NOT show the correct probabilities until another ‘calculate’ has been 
performed. 
 

4.2.3 The Tools Menu Functions 
 

• Tools > BN Images This enables the users to view as a graph any of the pre-defined 
BNs (i.e. the project level model and the various phase models). The images are 
picked up directly from the root directory of the application. 

 
• Tools > Clear Entered Data. Removes all the observations in scenarios connected to 

the specified model. 
 

• Tools > Generate Report Creates an HTML report detailing the models and their 
nodes. The long and short description of each node is reported, along with any 
answers defined for it in the connected scenarios. Nodes can be made reportable or 
non-reportable from the BN view (see Section 4.5). 

 
• Tools > Export Statistics This option sends current statistical information (from the 

most recent propagation) about each ‘reportable’ node in the current model file to a 
CSV (comma-separated) file. In the case of multiple scenarios being active on a model 
only the statistics from the last scenario propagated will be available. An example of 
the format of the CSV data can be seen in Table 1.  

 
 

Table 1: Example of exported statistics 

Model Node Mean Variance Standard 
Deviation Median 

Testing Phase 

testing staff quality 
indicator medium (e.g. staff 
turnover) 2.5 2.059174 1.434982284 2.500000106

Testing Phase 
testing staff quality 
indicator weak 2.5 2.327544 1.525629042 2.500000124

Testing Phase 

testing staff quality 
indicator strong (e.g. 
experience) 2.5 1.537266 1.239865324 2.500000176
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Testing Phase 
overall testing & rework 
management quality 2.5 0.877849 0.936935975 2.500000151

Testing Phase rework effort  2.5 1.333333 1.154700547 2.50000004
Testing Phase rework personnel quality 2.5 1.333334 1.154700613 2.500000205
Testing Phase residual defects post 217.8448 144289.2 379.8542435 101.9118027
Testing Phase defects fixed 32.26082 5432.162 73.70320253 11.40863931
Testing Phase residual defects pre 408.2136 2132421 1460.281254 118.7499264
Testing Phase defects found 75.9466 27744.11 166.565618 31.34826011

 
 
 

4.3 The explorer view 

 
The explorer view is situated on the left hand side of the application window. It contains a 
complete list of all the models that are contained within the top-level model at any point.  
 

 
Figure 10 The explorer view 

 
Clicking on an item in the tree view will select the item. Full details of that item will 
subsequently be displayed in the work area (on the right hand side of the application window). 
Either the BN view or the questionnaire view will be shown depending on which of the 
corresponding tabs is selected in the work area. 
 
Any item in the explorer view can be renamed – this is crucial if you want to create your own 
tailored version of an existing model. To rename an item you have to click on it once and then 
leave the cursor over the item. You will then be able to type in text to change the name. 
Changes are committed only once you have pressed the enter key.  
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If the top-level item is selected (see Figure 10) then a view of the top-level model will be 
displayed in the work area.  When a pre-defined model is loaded for the first time this will 
appear empty.  
 

4.4 The work area: questionnaire view 

If the questionnaire tab is selected in the work area (see Figure 11) then the work area will 
display a questionnaire for the item selected in the explorer view (except if the top-level item 
is selected, because in this case the questionnaire is empty). 
 

 
Figure 11 The work area tab bar 

 
The components of the questionnaire view are shown in  
Figure 12. In this section we explain the following components: 
 

• The questions list (including how to select, edit and answer questions) 
• The questionnaire toolbar 
• The scenario manager 
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Figure 12 The questionnaire view 

 

4.4.1 The questions list 
There is a list of questions that corresponds to each particular node for the selected model 
item. Questions are grouped under questionnaire headings. The headings are shown in larger 
black text, while the questions are slightly indented and shown in blue. 
 
The questionnaire headings act simply as a convenient mechanism for grouping related 
questions together. These headings, like the questions themselves, are editable and users can 
define their own headings so that they can group questions in a way that they feel is suitable 
for a particular model or application. 
 
Questions and headings are selected by clicking on their short description. When selected, 
their background colour will change to light blue. Clicking on the short description again will 
deselect the question or heading. Multiple items can be selected if the control key is held 
down during selection. Functions applied when questions and headings are selected will then 
be applied to ALL selected items.  
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By default questions appear in the question list unexpanded, showing their short description 
and their answer box. For questions whose answer has an ordinal scale measurement (such as 
‘very low’ to ‘very high’) the answer box is a combination box containing the set of possible 
answers. For questions that require a numeric answer, the answer box is a text box, which 
takes only numeric key presses.  
 
The expanded version of a question (see 
Figure 13) displays more details about the question including guidelines on when, how, and if 
it should be answered. Non-numeric questions will also display a list of possible answers. The 
answers consist of a tick box (for answering the question with a single answer), a text box (for 
soft evidence) and a short description of the answer. To expand a question, select the question 
and then click on the ‘Expand/Retract’ button on the questionnaire toolbar (the button at the 
top of the toolbar). 
 
 

 
 

Figure 13 The question component, expanded and retracted 

 
 
Note that both discrete and numeric questions will display a longer description when expanded.   
 
Questions can be answered via a number of mechanisms. In the case where the question has a 
non-numeric answer: 
 

• An answer can be selected from the combo box. The selection of ‘No answer’ will 
withdraw any current observation for that question.  
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• In the expanded view one of the available tick boxes can be selected. Note that 
clicking again on the same tick box withdraws the observation. 

• By entering soft evidence. This is done by typing numeric values into the text boxes to 
the right of the answer tick boxes. Any positive number can be entered. When the soft 
evidence is applied to the underlying BN it is normalised – the red bar directly under 
the answer description represents its normalised value.  

 
Questions that require numeric answers can only be answered by typing answers into the 
answer text box. 
 

4.4.2 The Questionnaire Toolbar 
The questionnaire toolbar (Figure 14) contains a number of buttons, which perform functions 
on the selected questions and question headings. 
 

 
Figure 14 The questionnaire toolbar 

 
• Expand/retract button This toggles the expansion status of the selected items. If 

questionnaire headings are retracted then it will hide all its connected questions until 
expanded again. 

 
• Create monitor button This creates a monitor for all selected questions. The 

monitors are placed into the monitor panel (see Section 4.5.4). 
 

• Create questionnaire heading button When this button is pressed a new 
questionnaire heading is added at the end of the questionnaire. All selected items will 
be deselected and the new questionnaire heading selected. 

 
• Move items up button This moves all selected items one up the list. Questions can be 

moved between questionnaire headings using this function. 
 

• Move items down button This moves all selected items one down the list. Questions 
can be moved between questionnaire headings using this function.   
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• Toggle visibility This toggles the visibility of the selected components. Questions that 

are defined as being invisible will be displayed with grey short question text, rather 
than blue. Invisible items will not be shown at all when the model is loaded in viewer 
mode (see Section 4.7). Normally synthetic nodes are set as invisible by default. 

 
• Delete selected items In version 2.x this function ONLY deletes empty questionnaire 

headings.  In order to do this select the questionnaire heading that you want to delete 
(it must have no questions under it) then click on the delete button.  

 

4.4.3 The questionnaire scenario manager 
The scenario manager (shown in Figure 15) allows the user to manipulate many scenarios at 
the same time, and to plot the results on the same graph (via the monitors) for comparison 
purposes. 
 

 
Figure 15 The questionnaire scenario manager 

 
The scenario manager is available for all questionnaires. It can be expanded and retracted via 
the ‘expand/retract’ button that is situated in its top left corner. Along the top is a list of the 
available scenarios shown as tabs. The colours are significant: 
 

• A blue tab denotes an active scenario. 
• A grey tab denotes an inactive scenario. 
• The beige tab denotes the currently selected scenario. 

 
By default, when a model is opened it is configured with just a single scenario.  
Observations entered into questions will be held in that scenario. Scenarios can be added by 
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clicking on the ‘Add new’ button situated in the top right of the scenario manager. When it is 
clicked, the new scenario will appear at the end of the scenario tabs.  
 
Scenarios are toggled active and inactive by clicking on their connected tab button. Active 
scenarios are then made available in the questionnaire for answering. Inactive scenarios are 
not available in the questionnaire. Figure 16 shows a questionnaire and scenario manager 
configured with 4 scenarios, the first and last of which are active. (Note that the 'Forecast 
Horizon' functionality is not active in version 2.0 of JSIMP so the corresponding text box 
should be ignored and its value left at 1). 
 
 

 
Figure 16 The scenario manager with 2 active scenarios 

 
In the example in Figure 16 two columns of answer boxes are present: the first represents the 
first scenario, while the second is for the last scenario. Thus, observations placed into the first 
column will be applied to the first scenario, and observations placed into the second column 
will be placed into the last scenario. 
 
There are no restrictions on how many of the scenarios can be active in the scenario manager 
at any point (although screen real estate limits what is reasonable). It is useful to note that the 
order of the columns in the questionnaire is equivalent to the order of the active scenarios. For 
example, if we made scenario 2 active in Figure 16 then there would be three answer columns 
in the questionnaire, such that the middle column would now be connected to scenario 2.    
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The scenarios are independent of each other. Entering observations into one of them in no 
way modifies the others. 
 
Observations supplied for questions via their expanded view are applicable only to the left-
most active scenario. This is highly relevant if you wish to enter soft evidence. In this case 
you must ensure that the scenario into which you wish to enter the evidence is the only active 
scenario.  
 
The short and long descriptions of the scenario can be modified. To do this the relevant 
scenario must first be selected. Scenarios are selected by moving the mouse over the 
connected scenario button. It is crucial to note that NO mouse click is required for selection 
(mouse clicks as discussed above are for making scenarios active/inactive). The selected 
scenario is shown in beige, while its details are present in the large beige rectangle directly 
under the scenario tab buttons. Once the scenario has been selected, its long and short 
descriptions can be modified simply by clicking on the relevant description and typing in the 
modifications.  
 
Scenarios are deleted by firstly selecting the scenario that you wish to delete (see above for 
how to select a scenario), then clicking on the delete button situated on the bottom right of the 
scenario manager. 
 
 

4.5 The work area: BN view 

 
The BN view is available when a model item is selected in the explorer view and the BN view 
tab is selected in the work area. The only exception is if the top-level object in the explorer 
view is selected, in which case a graphical view encompassing all the phase and project 
models will be displayed. 
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Figure 17 The BN View 

 
A typical example of the BN view is shown in Figure 17 – it displays a list of the nodes in the 
selected model item. The BN view has four main components:  
 

• Attribute list 
• Toolbar 
• Equation editor (not shown in Figure 17) – this provides the mechanism for editing 

NPTs 
• Top-level BN view (not shown in Figure 17) – this provides the mechanism to link 

appropriate phase models 
 

4.5.1 Attribute list 
Each node is represented by a row, followed by a number of attributes displayed in columns 
(topped by the name of the attribute).  
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The first column in the list is the name of the node. This can be changed by clicking once on 
the name, supplying the required text and then pressing the enter key. 
 
The node names are displayed in one of three different colours: 
 

• Green This means that the NPT for the node is editable and that it has been fully and 
correctly specified. 

• Red This means that the NPT for the node is editable but that it has been incompletely 
and/or incorrectly specified. 

• Grey This means that the NPT for the node is not editable. 
 
Initially, all node names will either be green or grey. A node will only become red when a 
user edits the NPT and leaves something unspecified or incorrectly specified. The model can 
still be used, however, but it means that the NPT used will be the last correctly specified one. 
See Section 4.5.4 below for more information on editing NPTs. 
 
The following additional attributes are available for nodes: 
 

• Visible This determines whether the node is visible in the BN view in viewer mode. 
Regardless of this attribute value, the node is always visible in edit mode. 

• Reportable This determines whether the node is output when a report is generated. 
• Input A node defined as an input node is configured to receive as input some 

information from a previous phase model. In the pre-defined JSIMP model input and 
output nodes are currently not used. 

• Output A node defined as an output node is configured to send information as input 
to another phase model (see comments for Input above). 

• Threshold Value A threshold value can be defined for any node. The threshold value 
is normally either a desirable value that the user wishes to see the node reach or some 
limit above or below which the value should not cross. Any set threshold values are 
plotted on the monitors relevant to the node, so that users can see at a glance the 
relationship between the predicted distribution for the node and the threshold value. 

 
In viewer mode, only the (uneditable) node name and the threshold value will appear in the 
attribute list. 
 

4.5.2 The BN view toolbar 
The BN view toolbar (Figure 18) provides a number of functions that can be applied on the 
selected nodes in the BN view. Nodes are selected by clicking on their names. Multiple nodes 
can be selected by holding done the control key while selecting. 
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Figure 18 The BN view Toolbar 

 
The functions have the following effects: 
 

• Create monitor This will create a monitor for each selected node.  The monitor will 
be appended to the monitor panel (see Sections 4.5.4 and 4.6.2). 

 
• Move node up in the list This will move all selected nodes one up the list. 
 
• Move node down in the list This will move all selected nodes one down the list. 

 
• Edit the node NPT This will bring up the equation editor, a modal window in which 

you can edit the node's NPT. The type of form displayed is dependent on the node. See 
Section 4.5.4 for full details. 

 
In viewer mode, only the ‘Create monitor’ button is available to the user. 
 

4.5.3 The top level BN View 
The top level BN view (shown in Figure 19) is available when the top item in the explorer 
view is selected. It displays a representation for each model item as a blue rounded rectangle.  
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Figure 19 The top level BN View 

 
JSIMP automatically adds a new rectangle for each imported model. It is not possible to add 
rectangles (models) manually via the BN view.   
 
Any of the pre-defined phase models (but NOT the project level model) may be linked. (In 
general model A may be linked to model B if A has an output node of the same type as an 
input node in B; each phase net has two pre-defined input nodes and two pre-defined output 
nodes). 
  
Links are created via the link tool (available from the tool bar). When the link tool is clicked a 
new link will appear at your mouse cursor. You should then click somewhere in an empty part 
of the canvas. A new (selected) link will appear with two control points (light grey boxes) at 
either end of the arrow. Clicking and holding down the mouse pointer inside a control point 
allows you to drag it around the canvas. Releasing the mouse pointer leaves that end of the 
arrow at that location. If an end is dragged and released inside a model (the blue rectangles) 
then that end will become anchored to that object.  
 
Links are created by dragging the two ends of an arrow into different models. The source 
(output) model must be connected to the line end of the arrow, while the target (the one that 
receives the output of the source) should be connected to the arrow end. 
 
Links are created in JSIMP by matching the output nodes of the source model to the input 
nodes of the target. These attributes are defined in the BN view (See Section 4.5). 
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Links and models can be removed by right clicking on the selected item then selecting 
delete from the subsequent pop-up menu.   
 
Note that in version 2.x of JSIMP you will not be asked for confirmation when you delete a 
link or model via this mechanism.  
 

4.5.4 The NPT editor 
 
The NPT editor allows users tailoring models to modify the NPTs of certain nodes. As 
mentioned above, the way in which the NPT for a particular node can be edited, and indeed 
whether it can be edited at all, depends on the type of node.  
 
Prior probability editing 
 
For leaf nodes, it is possible to specify the prior probabilities directly. When a leaf node is 
selected and the NPT editor button clicked from the BN view, the NPT editor window appears 
as shown in Figure 88 below. 
 

 

Figure 20 The prior probability editor 

 
The probabilities can be modified as required by changing the values in the text boxes. Note 
that you do not have to ensure that the probabilities sum to one; when you apply the NPT 
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changes by clicking the OK button, the probabilities will be normalised automatically. The 
resulting NPT can be checked by opening the NPT editor again for the selected node. 
 
Node expression editing 
 
For some nodes, it is possible to provide an expression that defines the entire NPT. The NPT 
editor window for nodes of this kind looks like that shown in Figure 21 below. 
 

 
Figure 21 The node expression editor 

 
The function type should first be selected; the parameters that are appropriate for the selected 
function type can then be entered. The parameter values specified can themselves be 
compound mathematical expressions and they can also refer to the node’s parent(s) if 
required. When entering a parameter expression, at any stage the name of a parent can be 
included by right clicking on the text box and choosing the appropriate item from the menu 
that pops up. (To specify a non-statistical mathematical expression, the function type needs to 
be ‘Arithmetic’. When this type is selected, only one parameter text box will be shown.) 
 
If there are errors in a parameter expression, the text box will be surrounded by a red border. 
More information about an error can be displayed by moving the mouse over the text box.  
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All nodes will initially have a default NPT. At any stage it is possible to return the node’s 
NPT to this state by clicking on the ‘Reset fields to default values’ hyperlink. Conversely, if it 
is decided that the default NPT expression for a node needs to be changed, the expression 
currently shown in the window can be used as the new default by clicking the ‘Set current 
field values as new defaults’. This latter option should never really need to be used. It should 
only be used if there is an exceptional reason why the default formula displayed to a user 
when they begin tailoring the model is perhaps inappropriate or misleading. 
 
Once the OK button is clicked, the new expression will be applied. If the NPT edit is 
successful, the window will disappear and the node name will be coloured green in the BN 
view.  
 
State expression editing 
 
For some nodes that have a single parent, it is possible to specify a different expression for 
each state of the parent node. The state expression editor window is shown in Figure 22 
below. 
 

 
Figure 22 The state expression editor 

The principle is similar to the node expression editor described earlier. When a parent state is 
selected on the left of the screen, an expression editor corresponding to that parent state value 
is shown on the right. Expressions must be supplied for all parent state values before the NPT 
can actually be updated. If all expressions are complete and correct, the state labels on the left 
should all be green. 
 
As with the node expression editor, the window contains hyperlinks that allow the default 
NPT values for the node to be restored and set. Note, however, that clicking on these links 
will affect the entire NPT, not just the expression for the currently selected parent state. 
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4.6 The Monitor Panel 

The monitor panel (Figure 23) is situated on the right hand side of the application window. 
Whenever monitors are created via the BN and Questionnaire view they are placed onto the 
monitor panel. 
 
The monitor panel takes up quite a lot of screen real estate. For this reason it can be 
minimised and maximised via the arrow button situated at the top left of the panel. 
 
 
 

 
Figure 23 The monitor panel 

The monitor panel has two main components: 
 

• The monitor panel toolbar 
• The monitors 
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4.6.1 The Monitor panel toolbar 
The monitor panel toolbar contains functions that operate on selected monitors. Monitors are 
selected by clicking on the monitor name (in the top left of each monitor). Once selected, 
monitors turn green. They can be deselected by clicking on the monitor name a second time.  
The functions are: 
 

• Move selected monitors up This moves all selected monitors one up in the monitor 
panel. 

 
• Move selected monitors down This moves all selected monitors one down in the 

monitor panel. 
 

• Close selected monitors This closes all the selected monitors. 
 

• Select/Deselect all monitors If one or more monitors are selected then this function 
will deselect them all. Conversely, if no monitors are selected then clicking this button 
will select them all. 

 
Only a single monitor can be open for a given node at any point. If a new monitor is requested 
for it then that monitor is selected and moved to the top of the list. 
 
The monitor panel functions are also applied to monitors that haven been detached (See 
Section 4.6.2 for more details on detaching monitors from the monitor panel.) 
 

4.6.2 Monitors 
Monitors (see Figure 24) display probability information for a selected node. They are created 
by selecting the relevant node in the BN or questionnaire view and clicking on the ‘Create 
monitor’ button in the connected toolbar (see Section 4.5). A newly created monitor will be 
added to the monitor panel (see Section 4.5.4).  
 
Monitors can be decoupled from the monitor panel by clicking on the ‘Decouple/couple 
monitor’ button’ on the top right of the monitor. A decoupled monitor is removed from the 
monitor panel and placed into its own frame, after which it can be resized and minimised like 
any other window. To re-couple it, simply click again on the ‘Decouple/couple monitor’ 
button.   
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Figure 24 A Monitor 

 
A monitor has two view modes. The mode is toggled by clicking on the ‘Mode’ button in the 
top right hand corner of the monitor (see Figure 24). The modes are: 
 

• Probability Mode This is the default mode, shown in Figure 24. This displays the 
probability distribution for the node from the last calculation (see section 4.2). The 
states are shown on the x-axis and the y-axis contains a probability between 0 and 1. 
The median value of the probability plot is shown in brackets after the name in the 
legend (but only after the first calculation). If a node has a threshold value set then this 
is displayed as a vertical line at the relevant point on the x-axis. 

 
• Statistics Mode This displays a range of summary statistics for the node (see Figure 

25), including the mean, median, the lower (0.25) percentile, and the upper (0.75) 
percentile. The 0.5 confidence interval is shaded blue between the upper and lower 
bound if there is more than one plot on the graph (see below). 

 
If a monitor is created where the scenario manager (see Section 4.4.3) has more than one 
scenario then the resultant monitor will have a set of data for each scenario. Figure 25 
displays an example of this.  
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Figure 25 Monitor created from a questionnaire with multiple scenarios. 

In the statistics mode the scenarios are displayed in series. However, because there is no 
inherent order in the scenarios in JSIMP this fact (and that fact that they are joined up) can be 
ignored. 
 

4.7 Application modes – editor/viewer 

The JSIMP application has two modes of use: an ‘editor’ mode and a ‘viewer’ mode. As 
discussed in Section 6, development users normally work in editor mode and then create 
applications that are used in viewer mode by end-users. 
 
The editor mode contains all the functionality of the tool, while the viewer mode has a 
number of functions disabled. All of these disabled functions are the ones that allow editing of 
the questionnaire and BN view, specifically: 
 

• In the BN View the buttons for moving nodes up and down and the button for editing 
the NPT are disabled. In addition only the node name and threshold value columns are 
shown in the attribute list. 

• In the questionnaire view, the buttons for creating new questionnaires, for moving 
questions up and down, for making questions visible/invisible and for deleting 
questions are all disabled. 
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Questions that have been defined as invisible in the questionnaire view (see Section 4.4.2) 
will not be displayed in the questionnaire list. Similarly, nodes that have been defined as 
invisible in editor mode will not be displayed in the BN view when the tool is used in viewer 
mode. 
 
Once a development user has finished all necessary tailoring, he/she can generate an 
application by switching the tool to viewer mode. This is done by a very simple edit to the 
text file named ‘minerva.properties’ that is situated in the root directory of the JSIMP 
application.  Specifically, change the following line: 
 
uk.co.agena.minerva.editable=true 
 
to 
 
uk.co.agena.minerva.editable=false 
 
Also, assuming that the development user has created a tailored project specific model file (as 
described in Section 6) called, say "myproject.cmp" then change the following line: 
 
uk.co.agena.minerva.defaultModel= 
 
to 
 
uk.co.agena.minerva.defaultModel=myproject.cmp 
 
making sure to include the file in the root directory of the JSIMP application when it is give to 
end-users.  
 
These changes will not take effect until the next time the application is started. To revert back 
to editor mode simply reset the uk.co.agena.minerva.editable property to true. 
 

4.8 Web enabled version of JSIMP tool 

JSIMP can be executed over the web using the Webstart technology. Full instructions on how 
to upload the Webstart version of JSIMP to a web server are provided in the Webstart zip file 
that is supplied along with the standard JSIMP distribution zip file.  
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4.9  Application FAQ 

Q) How do I create a monitor for a node? 
A) Select the node you are interested in from either the questionnaire or the BN view. Then 
click on the create monitor button in the toolbar to the left of the questionnaire or BN view.   
 
Q) I’ve entered some answers. How do I see the results? 
A) Create a monitor for each node/question you are interested in, then click on the ‘Calculate’ 
menu item. The model will propagate and display the results in the monitors. 
 
Q) How do I add more questions to the questionnaire? 
A) You cannot. When a model is imported there will be a question for every node in the 
questionnaire and no more can be added. They can be made invisible (when the model is 
opened in viewer mode) by using the visible function in the questionnaire. 
 
Q) I want to delete a link I have created between two models 
A) See section 4.5.3. 
 


	Introduction
	Overview of main JSIMP BN model
	Attributes associated with resource performance
	Attributes associated with technical quality
	Attributes associated with process quality
	Attributes associated with cost and schedule
	Outputs/predicted attributes

	Example: using the model
	JSIMP TOOL USER MANUAL
	Introduction
	The menu bar functions
	The File Menu Functions
	The Calculate Menu Functions
	The Tools Menu Functions

	The explorer view
	The work area: questionnaire view
	The questions list
	The Questionnaire Toolbar
	The questionnaire scenario manager

	The work area: BN view
	Attribute list
	The BN view toolbar
	The top level BN View
	The NPT editor

	The Monitor Panel
	The Monitor panel toolbar
	Monitors

	Application modes – editor/viewer
	Web enabled version of JSIMP tool
	Application FAQ


